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Wizcon 7, Version 7.61 Release 

Notes  

Introduction 

This document includes updated information for Wizcon 7 for Windows and Internet, 

Version 7.61. The information in this document contains the problems that were detected on 

Wizcon previous version, Wizcon version 7.6, and solved in the version. This document also 

includes Wizcon version 7.6 Release Notes. 

 

Solved Problems 

The following problems were detected in previous version and solved in this 

version: 

1. Dynamic elements whose properties depend on two different tags did not 

work correctly in the browser (W41SPR004). 

2. Event summary did not show the user who acknowledged a remote alarm 

(SPR 299). 

3. Report fields intended for future tag values displayed existing tag values 

instead of question marks (SPR 322). 

4. Tag limits were not verified when loading recipes (SPR 325). 

5. WizPro crashed when importing alarms (.als file) from older versions of 

Wizcon (SPR 327). 

6. When alarms were configured to display the tag value, using @tagname, 

(where tagname is the name of the tag) and you changed the language using 

the Multi Language Support, the Event Summary displayed the tag name 

instead of the value. New alarms (that is, alarms generated after the language 

was changed) were displayed correctly (SPR 328).  

New tuning parameter MLS_RELOAD_OPEN_ALARMS is added to Wizcon 

version 7.61. Enter this parameter manually to the Wiztune.dat file. When 

MLS_RELOAD_OPEN_ALARMS = NO – existing alarms will not be affected 

by the language change, and new alarms will be displayed in the new 

language. When MLS_RELOAD_OPEN_ALARMS = YES, or if the parameter 
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is not added to the Wiztune.dat file at all (default) – changing the language 

will affect existing alarms as described above. 

 For the changes to take effect, please restart Wizcon. 

7. Buttons in the Report Definition dialog box did not work properly in the 

Italian Version (SPR 330). 

8. Problem in printing ESC sequence in alarm history - when ESC sequence 

was used, only printed on-line alerts were affected, Report alarms could not 

be printed properly when configuring the ESC parameters (SPR 332).  

9. Problem in Sampler (sampling tags) after 49.7 days. The problem was caused 

by the Windows NT API GetTickCount that resets samplings after 49.7 

days (SPR 333). 

10. Errors in the Edit dialog box of an Image were detected in the Japanese 

version (SPR 335) 

11. Exit Wizcon could not be disabled using authorization mode in the German 

version (SPR 336). 

12. Ctrl-P (print) and Ctrl-R (re-paint) did not work when the image was not in 

Edit Mode (SPR 337). 

13. Popup and Event Summary stopped updating alarms until alarm was 

acknowledged (SPR 341) 

14. Start time could not be set properly in a Web Trend (SPR 343). 

15. Wrong characters were being written in the Wizcon Japanese version (SPR 

344). 

16. Problems using the "%" character in the Trend Profile Add the new tag 

dialog box label field (SPR 348). 

17. New tuning parameter CHR_SHOW_COMPRESSION_WARNING was 

added to Wizcon version 7.61 disabling data compression warning messages 

during history reading (SPR 352). 

Enter this parameter manually to the Wiztune.dat file. When 

CHR_SHOW_COMPRESSION_WARNING = NO – messages about data 

compression will not be displayed. When 

CHR_SHOW_COMPRESSION_WARNING = YES – (default), or if you 

choose not to add this parameter to the Wiztune.dat file at all, each time 

compression will be performed an appropriate message will be displayed. 

Please restart Wizcon for the changes to take effect. 

18. Wrong font bar icons in Image in the German version (SPR 353). 

19. User Logout caused an abnormal exit of Wizcon in the Italian Version (SPR 

354). 

20. The Smooth feature in the Browser Image Applet did not accept negative 

values for BCD tags (SPR 356). 
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21. Alarm objects in Images did not work if the alarm was issued from an add-on 

application using the WizStartAlert API. Image could not change according 

to the definition when it was operated by an external API (SPR 357). 

22. Wizcon could not be loaded if the Operating System had no network card 

and network installed (that is, if the file ICMP.DLL is missing). 

23. Creating any object from the Drawing bar enabled the Go to zone button, 

even when no zone was configured. 

24. The Paste from clipboard command was enabled even when no object was 

copied to the clipboard. 

25. Mouse pointer icon did not behave properly when the transparent setting was 

assigned to an object. 

26. Modifying the border of a Slider Image did not take effect until the image 

was reopened. 

27. Saving an image twice using the Save as command caused the image to 

disappear until refresh. 

28. Rotating a bitmap from the Operations toolbar showed an empty error 

message. 

29. Bar graph was not displayed properly in a Web application trend. 

30. Layers authorization did not work as defined in a Web application. 

31. Enhancing Cluster layer support by adding a new tuning parameter 

IMG_CLUSTER_USE_LAYER. Enter this parameter manually to the 

Wiztune.dat file. When IMG_CLUSTER_USE_LAYER=YES cluster will be 

used with layer support. When IMG_CLUSTER_USE_LAYER=NO, or, if you 

choose not to add this parameter to the Wiztune.dat file at all, cluster will be 

dropped to the first layer (default behavior). 

32. Any user could unlock the station using the WizGina security system. 

33. WizGina security system did not work correctly when the user was defined 

in a Workgroup. 

34. Error messages were added to the WizGina security system, informing the 

user of wrong user name and password when trying to Logon. 
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Wizcon 7, Version 7.6 Release 

Notes  

Introduction 

This section includes updated information for Wizcon 7 for Windows and Internet, Version 

7.6. The information in this document contains late breaking changes and additions to 

Wizcon 7.6 What’s New guide.  

What’s New 

Listed below are some of the new or improved features in Wizcon 7.6, as entered 

in the What’s New guide.  

� Internet Features: 

Remote User Login 

Popup Events Summaries 

Viewing Alarms in History Mode 

Modifying Trends 

Displaying a Grid in Trends 

� Modifying Object Properties 

� Line Properties 

� Transparent Bitmaps and JPGs 

� Converting Metafiles to Wizcon Objects 

� Select Before Execute 

� Browse Option for Cluster Tags 

� System Security 

� Audit Trail - Log Operator Actions 

� Converting Communication Block Definitions 

� Converting Alarm/Tag Definitions 

� Using External Conversion Utilities 

� Expressions in Alarms 
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� Assigning Groups to Alarms 

� Locating Alarms and Tags 

� Wildcard Filters for Alarm Objects 

� Alarm Filters 

Wizcon’s New or Updated Internet Features 

Described below are Wizcon’s new and/or updated Internet features. 

� Printing Applets from your Web Browser 

There are two ways to print Applets (i.e., Annunciator, Image and Trend) 

from your Web Browser:  

• Using the browser’s Print button. 

• Using a Java Script function 

4 To print applets using your browser’s Print button 

Using your browser’s Print button, the applet will be printed as viewed on 

screen. 

To print the applet, you simply have to click on the Print button. 

Note: Printing using the Print button requires no security configuration 

and is enabled through both browsers types. 

4 To print applets using a Java Script function 

Using the Java Script function scriptPrint() you can print only the 

content of the applet. The function returns VALID for a valid operation or 

NOT_VALID for an invalid operation. 

Following is an example of creating a script printing job for an image 

applet (note that the same is applicable for the other applet types as well): 

<script language="JavaScript"> 

        function printImgApplet() { 

 rc = document.WizAppImg.scriptPrint() 

  alert(rc) 

 } 

</script> 

 

<applet NAME="WizAppImg" ……..  </applet> 

Note: when the applets are running locally both on Netscape 

Communicator and on Internet Explorer, no additional 
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security settings are required However, when the applets 

are running via a Web server, you have to configure 

printing security settings (see below) and this can be done 

only when using Internet Explorer. 

4 To configure Internet Explorer printing security settings: 

Open your Internet Explorer browser. 

From the Tools menu, select Internet Options. 

Click on the Security tab to open the Security page and select the Web 

content zone through which you want to enable printing. 

Click on the Custom Level button to open the Security Settings dialog 

box. 

Scroll down the Settings tree to the Java settings and select the Custom 

radio button under Java Permissions: 

 

Click on the Java Custom Settings button to open the Internet dialog 

box. 
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Click on the Edit Permissions tab and scorll down the tree’s Unsigned 

Content to the Additional Unsigned Permissions, then to the Printing 

permission and click the Enable radio button. 

 
 

Click OK to confirm the settings you configured. 

� Trend  

This version enable printing trends located in a remote station from the 

Internet Explorer using the trend’s Print command (located under the 

Options menu). However, you have to configure Internet Explorer Printing 

security settings (as explained above) to be able to do so. 

Note: Printing trends using the trend’s Print command is not enabled 

on Netscape Communicator. 

� Memory consumption with Wizcon image in browser 

When running an image in the browser and switching repeatedly between 

zones, one can see that the memory consumption of the browser process is 

increased. The source for this problem lay on memory leak caused by 

“createImage()” method used by image mechanism. The problem is 

documented as SUN bug: ID 4014323. 
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eMation R&D implemented all the recommended in order to reduce the 

memory leak. Tests that have been made show significant difference before 

and after the implementation. However, since the SUN bug still exists, there 

is no 100% guaranty for non-leaking system. 

� Previous versions Images profiles 

Images profiles (files of type *.wnp) that were created with Wizcon version 

7.51 or a previous 7.6 beta version, should be recreated and re-saved before 

loading version 7.6 Image Applet. 

To recreate a *.wnp profile: 

1. Delete the old files. 

2. Open the relevant image and save it. 

A new *.wnp is created under Pictures in the Docs directory. 

Image Enhancements 

� Pasting Objects from the Clipboard 

When pasting objects from the clipboard they are transferred by priority 

according to the object type: The first object to be transferred will be a 

Wizcon object, the second will be a Metafile and the third will be a BMP. 

� Gradient Pattern 

When setting the fill property of an object to gradient, the object is displayed 

with no frame. 

� Remote Station Slider 

A slider on a remote station cannot have the “On dragging to Image, on 

dropping to Tag” property. 

� Cluster’s Alarm Definition 

You cannot modify the Alarm definitions in a Cluster or an instance. To 

change the alarm definition, use the Edit Properties. 

� Unsupported Edit properties 

The following Edit properties are not supported: Font, Line Style and 

Transparent Color. 

� Keys Ctrl-F and F3 usage 

In Edit mode, the keys Ctrl-F and F3 are used as shortcuts to search 

functions. Otherwise (i.e., when not in Edit mode) these keys can be used as 

accelerators for macros. 

Networking 

� The Protocol dialog box was changed 

Wizcon 7.6 Protocol page of the Network dialog box was changed to enable 

you choose whether or not a communication error window will pop-up. 
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By default, the Show popup window on communication error option is 

checked. 

System Security (WizGINA) 

� Changing Security restarts the Windows Explorer 

When you chage the security level from “Full Security” to “Authorized 

User”, the Windows Explorer restarts, and all the programs in the startup will 

be launched again. 

� Installing System Security 

The System Security is not installed by default. To install the System 

Security (WizGINA) you have to select it from the list of components during 

the installation procedure. 

� Enable / disable access to Wizcon help files 

To maintain full security, you should check whether you want to provide 

users with the access to Wizcon help files. You can configure the access to 

Wizcon Help menu through the Menu Authorization command. 

� WizGINA disables the shortcut to the NT Task Mangaer  

When WizGINA is installed the shortcut to the NT Task Manager using the 

keys  CTRL+SHIFT+ESC, is disabled, even when Wizcon is not running. 

New APIs  

The APIs listed below were added to Wizcon 7.6. For detailed information on 

each of these functions please refer to file Readme_API.doc located under 

<Wizcon installation path>\ToolKit\Help (where <Wizcon installation path> is 

the path to which you installed Wizcon). 
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• WizStartAlertWithGroup  To generate a new alarm.  

• WizStampAlertWithAcknowledge To modify an alarm status. 

• WizAckClassAlertWithAcknowledge  To acknowledge an alarm and modify 

its class. 

• WizAddAlertDefExp  To add an alarm definition. 

• WizFindAlertDefExp  To find the first alarm definition ID that matches your 

search parameters. 

• WizChangeAlertDefExp Modifies an existing alarm definition. 

• WizGetAlertDefExp Retrieves the definition structure of a specific alarm 

definition ID. 

• WizIsGateExistInAlarmExpression To check the existence of a gate in an 

alarm expression. 

• WizGetStnStatus Returns the station status. 

• WizGetStnIdFromAlert To retrieve the station ID of an alarm. 

Miscellaneous 

� Error Messages 

All the error messages have the ‘always on top’ property, i.e., an error 

message will always pop-up on top of all other windows. 

� New Wizcon Macros 

This version provides additional keys to be used for Macros: PgUp, PgDn, 

Home, End. 

� Hebrew Tag Names 

Hebrew Tag names are not supported. 

� Group Settings 

The Group settings in WIZDEF were moved to an API: WizIsGroupEnabled 

(this change is significant only for add-ons). 

� Startup / Shutdown progress indication 

The progress of both Wizcon Startup and Shutdown is indicated on screen. 

Application Notes 

� Installing Wizcon 7.6 on a PC with a Previous Wizcon 7 Version 

As in many Windows products, it is recommend to uninstall previous 

versions of Wizcon 7, before installing the new version. However, it is 

possible to install Wizcon 7.6 to a different folder than W7.xx and thus 
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enabling the possibility to run both versions on the same PC. The following 

needs to be noted: 

1. The new MFC42.DLL installed with Wizcon 7.6 may cause problems 

with Wizcon 7.xx. Before installing copy MFC42.DLL from the 

windows systems folder to W7.xx BIN folder. 

2. After installing W7.5, WZ7 files will be linked to W7.6. To run W7.xx 

you can change this link in folder options or run WIZCON.EXE from 

W7.xxBIN folder with command line of WZ7. 

3. Wizcon installs and uses some OCXs. W7.xx may not work correctly 

with Visual Basics programs after installing  

Previous version of Wizcon for Internet(W4I): 

Wizcon 7.6 has built-in Web support, therefore it is advisable to remove the 

previous version of W4I and run the application using WZ7. 

Note: Users.dat file of Wizcon 7.6 will not work in previous versions of 

Wizcon. 

� To run properly, Wizcon 7.6 requires Winsock 2.0 to be installed in 

Windows 95. The installation automatically checks the winsock version and 

installs Winsock 2.0 if required. Winsock 2.0 is available on the Value Pack 

CD. 

� Wizcon 7.6 requires an ODBC support to be installed in all the operating 

systems. If your operating system is Windows 95, Wizcon setup verifies 

whether the ODBC support exists and installs it automatically if not. 

In other operating systems (WinNT 4.0, Windows 98 or Windows 2000) the 

ODBC support is built-in. However, if an error occurs during the installation 

regarding ODBC, you have to install the ODBC manually and then run the 

installation again. The ODBC installation can be found on the Wizcon for 

Windows and Internet CD. 

� Wizcon 7.6 should be used with Microsoft Internet Explorer 5.0 (with virtual 

machine 5.0 or higher) or higher, or with Netscape 4.7 or higher. 

4 To identify the virtual machine installed proceed as follows: 

1. Open Internet Explorer. 

2. From the Tools menu select Internet Options and then click on the 

Advanced tab. 

3. Browse down the Settings tree and check the Java console enabled 

option located under the VM settings. 

4. Restart your browser 

5. Select Java Console from the View menu to open the Java Console 

window where the version is displayed, e.g., Microsoft (R) VM for 

Java, 5.0 Release 5.0.0.3167. 
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� Setting Windows NT path variable 

For Windows NT users only: after installing Wizcon 7.6, you have to 

manually set your system path variable. 

 4 To set Windows NT path variable 

1. Click Start, click Settings, and then click Control Pannel. 

2. Select System to open the System Properties dialog box and click on the 

Environment tab. 

3. Click on the Path variable in the System Variables list, see that it is entered 

in the Variable box below and place your cursor in the Variable or Value 

field to enable the Set button. 

 

4. Click on the Set button to set the path and then click Apply.  

� The Java Applets for Wizcon version 7.6 were compiled using JDK 1.1.7. 

� When upgrading the application, you have copy class type files located under 

the Classes directory to Proj\Docs directory. 
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� When upgrading the application, make sure that the CLASSPATH system 

variable (if exists) points to the new installation path. 

� Firewall users: note that the port number for W4I Socket was changed. The 

new port is 3028. 

� Proxy Server users: you can load an HTML via Proxy. However, when an 

HTML page with an Applet is loaded, the Applet tries to open a Socket to 

the server on the computer from which it was loaded. Currently, there are no 

settings to enable such operation directed via the Proxy port. Therefore, 

when the Proxy server is completely isolated between the client and the 

server, communication will not be established between the Applet and the 

server. 

� On Windows 95 / 98 Wizcon Language (WIL) cannot be restarted on Save. 

WIL must be re-launched manually from the command line. 

Solved Problems 

The following problems were solved in this version: 

1. When chart in displayed in maximum screen width its menu bar cannot be 

seen (WSPR 219). 

2. When printing alarms online, the Umlaut characters are wrong. An additional 

tuning parameter has been added to Wiztune.dat. The use of 

ALERT_PRINTER_TARGET = FILE will define the output as directed to a 

file while the default means that the output will be directed to a printer. By 

adding this option we assure that all the characters should be converted 

correctly (including the German character Umlaut). (WSPR 238). 

3. Wizcon crashes when exiting while the Chart message box is open. (WSPR 

257) 

4. A trigger action will not work when the object is a defined cluster with 

dynamic definition, and tried to be displayed in an HTML document. (WSPR 

259). 

5. Data Entry window in the Web module of Wizcon 7.5 wrong behavior. 

(WSPR 264) 

6. Impossible to print the alarm Assist in Hebrew. (WSPR 266) 

7. DISKFULL query is being done on the wrong drive. (WSPR 271) 

8. Memory Leak problem when having grouped JPEGs in an image. (WSPR 

283) 

9. In HTML documents, when the tag value is changed, the leading zeros will 

appear although defined not to. (WSPR 298) 

 

 


